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Introduction

Copyist provides you with all the tools you need for creating a score from
the ground up, or for fine tuning a score created in QuickScore Deluxe,
Professional or Elite and saved as a Copyist file.

Copyist treats notes, staves, clefs and other musical characters as
graphical elements, and allows you the freedom to place elements on the
page regardless of musical rules. This freedom allows you to easily create
small excerpts to be included in work that is predominantly text, as well
as very complex scores which are very difficult to create using software
which must follow musical rules.

The placement and editing of objects such as staves, clefs, time
signatures, key signatures, notes and note markings is accomplished with
both mouse operations and with the use of an extensive command key
system.
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Getting Started

System Requirements
Copyist requires a 33  MHz 386 or faster Windows compatible computer
and a minimum of 4  megabytes of RAM to operate. A 33  MHz 486 or
faster machine with 8  megabytes of RAM is recommended. Windows 3.1
or greater is required.

Installation
To install Copyist, put the Copyist program disk into your disk drive,
make sure Windows is running and select Run from the Windows
Program Manager File menu.

Type “a:install” if your floppy disk is in drive A.

Type “b:install” if your floppy disk is in drive B.

Press ENTER. Copyist will now install itself onto your machine.

When Copyist installs itself, you will be asked a number of questions. In
most all cases, the answer should be obvious.

When the installer starts, you are given the choice to install Copyist or
not. Make sure Install Copyist is selected and click on the OK button.

Answer Yes to “Do you wish to install the Copyist Demo files? ” if this
is the first time that you are installing Copyist. If you've already installed
these files to the directory in which you are now installing Copyist, you
can answer No if you like.

Next you must select the drive onto which you wish to install Copyist.
Normally you will choose one of your fixed drives. Usually this is
drive C. You need at least 2.0  megabytes free on the drive on which you
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want to install Copyist. When you've selected the drive you want, click
on OK.

Choose the installation directory for Copyist. This is where Copyist will
put all its files. If you don't like the default CPYWIN, you can type in a
different directory.

The installer will next check to see if you have already installed Copyist
to the directory you specified. If it detects a prior installation you will be
asked if you want to proceed.

If you go ahead, Copyist will proceed to install itself in your installation
directory.

Next you are advised that Copyist needs the Mozart TrueType font. If
you already have this font on your system (probably because you have
installed a previous version of Copyist or QuickScore), you can reply No.
You can also reply No if you want to install the font yourself from
Windows. The Mozart font is in the file MOZART.TTF in the installation
directory. If you want to install the font yourself, see the section on
installing fonts in your Windows User's Guide.

Finally you are asked if you want to create a program group for Copyist.
Normally you will reply Yes. You can reply No if you already have a
program group for Copyist that is properly set up.

That's it! Copyist is now installed on your computer. Before you quit the
installation program, take a look at the readme file (click on Yes when
you are asked if you want to look at it) to see if there is anything that is
not in the manual that you should know about. You can print this file (it
is the file README.DOC in the directory in which you installed Copyist)
by loading it into the Windows Notepad and printing it from there.

Registration
Make sure you fill out and send in your registration card. It is important
that you are in our database so that we can provide you with technical
assistance when you need it. If you haven't sent in your registration card,
we can only give you limited assistance in setting up Copyist. Sending in
your registration card will also help us know who you are so we can send
you information about product updates and special offers.
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Moving Within a Score

Moving the edit cursor within a score can be done either with the mouse
or from the keyboard.

Moving the Cursor
The placement of symbols is determined by Copyist's edit cursor , a small
rectangular box that can be moved anywhere on the screen using the
mouse  and the cursor arrow keys.

To move the edit cursor with the mouse, simply click the left mouse
button anywhere on the screen - the edit cursor will immediately jump to
that position, with the center of the edit cursor aligned to the tip of the
mouse pointer.

To move the edit cursor with the cursor arrow keys, use Left Arrow,
Right Arrow, Up Arrow and Down Arrow to move the edit cursor one
space in the corresponding direction. CTRL+Left Arrow or
CTRL+Right Arrow will move the edit cursor to the next or previous
note in the current staff and CTRL+PAGE UP and CTRL+PAGE
DOWN will move the edit cursor to the previous bar or the next bar. The
HOME key moves the edit cursor to the previous staff and END moves it
to the next staff. CTRL+HOME returns the edit cursor to the top of the
page and CTRL+END moves it to the end of the page.

Use PAGE UP and PAGE DOWN to scroll the display to view other
portions of the page. You can also use the scroll bar at the right of the
Copyist window to scroll the display up or down.



5

Selecting, Deleting and Inserting
Pages
Page commands are two-key sequences that are used to move to different
pages within a score or to do page level editing to the score as a whole.

   action keystrokes

   go to next page pn

   go to previous page pp

   go to first page pf

   go to last page pl

   insert page pi

   erase page pe

You can also use tools on the Copyist toolbar to select, delete or insert a
page.

The Page Select Tool is the third tool from the right in the Copyist
toolbar. This tool allows you to select a new page.  In the center of this
tool you see the number of the page in your score you are currently
viewing. Clicking the page number itself brings up a small dialog box;
type in the number of the page you wish to go to and Copyist will
immediately jump to that page. Clicking on the right arrow will cause the
next page to be brought up onscreen and clicking on the left arrow will
cause the previous page to be brought up onscreen.

The Insert Page Tool is the second tool from the right in the Copyist
toolbar. Clicking on this tool causes a new page to be inserted before the
current page.

The Delete Page Tool is the tool at the far right in the Copyist toolbar.
Clicking on this tool causes the current page to be deleted.
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rtical and Horizontal
Position
Press the Insert key and the cursor will change to a cross that extends to
the edges of Copyist's window. This allows you to see exact vertical and
horizontal alignment of symbols if you need to. Press the Insert key
again and the cursor changes back to a box.
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Entering Symbols

Inserting from the Non-adjustable
Symbols Palette
Click on the Non-adjustable Symbols button in the Copyist Toolbar (the
fourth button from the left.) The Non-adjustable Symbols palette will
appear, showing you all of Copyist's non-adjustable symbols.

Select the symbol you want by clicking on it. The symbol you choose
appears on the Non-adjustable Symbols button.

Now enter the symbol on your page. Do this by holding down the SHIFT
key and clicking and holding down the left mouse button. The symbol
will appear at the mouse cursor. As you continue to hold down the
SHIFT key and to hold down the left mouse button, you can move the
mouse and the symbol will follow, until you have positioned it where you
want it on the page. When the symbol is positioned where you want it, lift
the left mouse button and the symbol will be placed onto the page.

Inserting from the Adjustable
Symbols Palette
Click on the Adjustable Symbols button in the Copyist Toolbar (the fifth
button from the left). The Adjustable Symbols palette will appear,
showing you all of Copyist's adjustable symbols.

Select the symbol you want. This symbol now appears on the Adjustable
Symbols button.

Enter the symbol on your page by moving the mouse pointer to where
you want the left edge of your symbol to appear and dragging the right
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mouse button to the right. The symbol will appear, with three adjustment
handles which let you change its shape and move it before you drop it
onto the page.

If you want to move the start of the symbol, click the left mouse button
on the left adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the handle and moving the start of the symbol.

If you want to move the end of the symbol, click the left mouse button on
the right adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the handle and changing the end of the symbol.

If you want to move the symbol up, down, left or right, click the left
mouse button on the middle adjustment handle to select it and then drag
the handle by clicking and holding down the left mouse button and
moving the mouse, dragging the handle and moving the position of the
symbol.

Once you have properly adjusted and positioned the symbol, click the
right mouse button or press the ENTER key to drop the symbol onto the
page. You can press the ESCAPE key if you want to cancel the
operation.

Inserting from the Keyboard

Single-Key Symbols

There are a number of symbols which can be placed into a score by
moving the edit cursor to the desired location and typing the single
keystroke shown in the following table:

   symbol keystroke

   sharp s

   flat f

   natural n

   double sharp x
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   dot d

   half note head h

   whole note head w

   quarter note head b

   quarter note head to left of
downstem

l

   half note head to left of downstem L  <Shift>l

   quarter note head to right of upstem k

   half note head to right of upstem K  <Shift>k

   drum note head X  <Shift>x

   closed diamond note head v

   open diamond note head V  <Shift>v

   ledger line z

   staff S  <Shift>s

   single staff line Z  <Shift>z

   guitar staff G  <Shift>g

   piano marking P  <Shift>p

   forte marking F <Shift>f

   mezzo marking M  <Shift>m

   number (for key sig) 0 .. 9

   fingering number <Shift>1 .. 5

Multi-Key Symbols

The following symbols require multiple (two or more) keystrokes. As
with the single-key symbols, they are entered at the cursor location.

   symbol keystrokes

   treble clef ct
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   bass clef cb

   treble clef 8va cT

   bass clef 8vb cB

   alto clef ca

   drum clef cd

   damper pedal on D+  <Shift>d+

   damper pedal off D-  <Shift>d-

   common time C+  <Shift>c+

   cut time C-  <Shift>c-

   stems <direction><duration>

   rests r<duration>

   bar lines <F6><line style><number of staves>

   turn ot

   reverse turn oT

   mordent om

   mordent with slash oM

   lower fermata of

   upper fermata oF

   grace note og<direction>

   copyright oC

   open circle (harmonic) oh

   accent oa

   straight cross ox

   heavy accent oA

   tenuto oo

   up martele ou

   down martele od

   up bow oU
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   down bow oD

   repeat oR

   measure rest or

   grand pause oG

   segno os

   coda oc

    first 10 user symbols A<1..0>

    last 10 user symbols A< <Shift>1..<Shift>0 >

Directions

   up -

   down +

Durations

   whole w

   half 2

   quarter 4

   eighth 8

   sixteenth 1

   thirty-second 3

   sixty-fourth 6

Line Styles

   vertical line at left of cursor l

   vertical line at right of cursor r

   end line (at right of cursor) e
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   brace b

   curly brace c

   dotted line d

   left repeat L

   right repeat R

Numbers of Staves
   1 .. 9

Clefs
The treble, bass and drum clef keystroke commands may be executed
with the cursor on any line of the staff, and Copyist will automatically
center the symbol on the correct line. However, when shift-dragging these
clefs from the symbols palette, you'll need to manually position them
correctly on the staff.

The alto clef symbol can be used to create other clefs as well, so the
cursor must be properly centered when entering the alto clef from the
keyboard. The less common tenor, soprano or mezzo-soprano clefs may
be created by centering the cursor on the second line from the top, the
bottom line, or the second line from the bottom, respectively and typing
ca. Alternatively, you can shift-drag the alto clef symbol from the
symbols palette to any position on the staff.

Drum clefs placed with the keyboard command cd cannot be placed
directly on a percussion staff (they will instead jump to the nearest five-
line staff). To place a drum clef on a percussion staff, you must shift-drag
it from the symbols palette, or move it there after entering it with the
keyboard command.

Time Signature
The Common and Cut-time signature abbreviations formed with the C+
and C- commands should be created with the cursor centered on the
middle line. Alternatively, you can shift-drag them from the symbols
palette to any point on the staff.
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Stems
When creating stems, the stem will go up from the cursor position if the -
(minus) key is pressed, and down if + (plus) is pressed. This may seem to
be backwards at first, but our experience has shown that this arrangement
makes more sense when using the + and - keys on the numeric keypad,
due to the placement of these keys. Stems for small note heads are
somewhat shorter than those for normal note heads.

Rests
Rests are created from the keyboard by pressing r followed by a duration
value. If entered from the keyboard, rests should be placed with the cursor
centered on the middle line of the staff, except for whole note rests, which
are created with the cursor centered on the second line of the staff. As
usual, you can shift-drag rests of any duration from the symbols palette to
any point on the staff.

Bar Lines
Bar lines are created by pressing F6 followed by a style key, as listed in
the table above, and the number of staves the bar line should encompass,
starting with the current staff. Alternatively, you can select any bar line
symbol from the adjustable symbols palette and manually place them
anywhere on the staff and then adjust them to any length. The brace or
curly brace is used at the beginning of each staff, the end line only at the
end of a score or section, and the regular bar line at all other bar line
locations. Bar lines are treated as part of the staff by the editing
commands.
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Editing Symbols

Selecting an Individual Symbol
To edit an individual symbol, you have to first select it by double-
clicking on it with the left mouse button. Copyist will find the single
object whose beginning is closest to the mouse pointer. An Edit menu
will appear, containing menu items that depend on the type of object
selected.

Selecting a Group of Symbols
To select a group of symbols, drag the mouse over the symbols, (click
and hold down the left mouse button and move the mouse until you have
encompassed all the symbols and then release the mouse button). The
selected symbols will be highlighted in reverse video and the Range Edit
menu will appear.

Vertical Range Editing
There are a number of special "vertical" edit commands which can be
applied to a vertical range the width of the entire page.

To define a vertical range, drag the cursor down and to the left while
holding down the left mouse button. An area the full width of the page
will be displayed in reverse video and the Vertical Edit menu will appear.

This menu allows you to erase the defined area (normally used to bring
systems or staves closer together) or to insert extra blank space between
systems or staves to improve legibility or to make room for text or special
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symbols like slurs and dynamics. You can also cut, copy, or move the
defined area.

Edit Operations

Cut

Cut removes the selected symbol(s) from the score and places the data
into the paste buffer, so that, if desired, it can then be pasted elsewhere in
the score or into the pasteboard.

Copy

Copy copies the selected symbol(s) and places the data into the paste
buffer without removing the data from the score. Copied symbols can
then be pasted elsewhere in the score or into the pasteboard.

Paste copied or cut symbols using  Paste, available under the Edit menu
or by pressing  CTRL+V. Paste pastes the most recently cut or copied
symbols at the cursor location. When you first paste a selection, the
cursor changes to a cross. You can then move the pasted symbols or
range or symbols anywhere on the page using the mouse or the arrow
keys. Once you have it positioned correctly, drop the symbols on the
screen by pressing ENTER or clicking the right mouse button.

Move

The Move option allows you to move any symbol or range or symbols to
another position on the page.

After this command is executed by selecting it from one of the edit
menus, the selected symbol or symbols will appear slightly distorted
(xored) and the mouse pointer will change to a cross. You can now move
the selected symbol(s) to any position on the screen using the mouse or
the cursor keys. For even finer control, hold down the CTRL key while
pressing the cursor arrow keys - the selected symbol(s) will move in the
specified direction one screen pixel at a time. Once you everything
positioned correctly, drop the symbol(s) on the screen by pressing
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ENTER or by clicking the right mouse button. You can cancel the Move
operation by pressing ESCAPE.

Beam

The Beam command in the Range Edit menu allows you to add beams to
groups of notes. It also allows you to add stems to individual note heads
or groups of note heads.

First select the notes you want to beam by dragging the mouse over them.
Do this by clicking and holding down the left mouse button and moving
the mouse until you have encompassed all the symbols, and then
releasing the mouse button. The selected notes are highlighted in reverse
video and an edit menu appears. Select Beam from the edit menu. Choose
one of the durations from the submenu, and then either Beam Up or
Beam Down from the next submenu.

If you want more than one duration for your beamed grouping (for
example a dotted eighth beamed with a sixteenth), choose Complex for
the duration and then Beam Up or Beam Down from the next submenu..
Now for each note in your group, select the duration for that note from
the dialog that appears. The Skip Note option in this dialog gives you the
opportunity to leave selected notes within the group unbeamed.

If you are beaming a single note head, a stem and flags are added to your
note head according to the duration and direction you specified from the
beaming submenus.

Adjust

Adjust Note
To adjust the placement of an individual note within a beamed grouping,
double-click on the note to select it and then choose Adjust Note from
the Edit menu. The mouse pointer will change to a cross. By holding
down the left mouse button or by using the keyboard cursor arrow keys,
you can drag the note to any new position. If you press and hold the
CTRL key while using the left and right arrow keys, you can move the
note left or right one pixel at a time. Press the right mouse button or press
ENTER to complete the operation. To abort the adjust operation at any
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time, press ESCAPE. Note that the Adjust Note function does not work
when an individual note that is not within a beamed grouping is selected.

Stem Height
To adjust the stem height of an individual note (or even the stem height
of a note within a beamed grouping), double-click on the note to select it
and then choose Adjust Stem from the Edit menu. A small handle will
appear to the left of the note (indicating the stem height) and the mouse
pointer will change to a cross. By holding down the left mouse button or
using the keyboard up/down cursor arrow keys, you can then drag the
stem to any new height. Press the right mouse button or press ENTER to
complete the operation. To abort the adjust operation at any time, press
ESCAPE.

 To adjust one or more stems simultaneously, use the mouse to draw a
range around the stem or stems you wish to adjust (be careful to include
all note heads and stem symbols). From the Range Edit menu that
appears, select Adjust. Select Upper Flags or Lower Flags, and the stem
height  handle will appear, as described in the previous paragraph. Follow
the directions in the previous paragraph to adjust your stems.

Adjust Symbol
To adjust an adjustable symbol (that is, one from the adjustable symbols
palette) double-click on it to select it and choose the Adjust option from
the Edit menu.

Two or more handles will appear on the object and the mouse pointer will
change to a cross. For most objects, the left handle affects the start of the
object, the middle handle allows you to move the object and the right
handle affects the end of the object. Click on one of the handles and hold
down the left mouse button while dragging to adjust the selected object.
Handles can also be selected by typing TAB (next handle) or
SHIFT+TAB (previous handle) and adjusted with the keyboard arrow
cursor keys. If the middle handle is selected, pressing and holding down
the CTRL key while using the left and right arrow keys allows you to
move the object left or right one pixel at a time. When the selected
adjustable symbol has been adjusted to your satisfaction, click the right
mouse button or press ENTER to complete the operation, and the mouse
pointer will return to its normal arrow shape. To abort the adjust
operation at any time, press ESCAPE.
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You can also select an adjustable symbol to adjust by drawing a range
around it with the mouse. From the Range Edit menu that appears, select
Adjust and then select Symbol from the submenu. Now adjust your
symbol as described in the preceding paragraph.

Adjust Beam
To adjust an individual beam, double-click on the top left edge of an
upper or cross beam grouping or the bottom left edge or a lower beam
grouping to select it. Now select Adjust Beams. The mouse pointer
changes to a cross and two handles appear - one to the left of the beam
and one to the right. The left handle adjusts the height of the beam, while
the right handle adjusts the beam angle. Select either, and press and hold
the left mouse button while dragging or use the keyboard cursor arrow
keys to adjust the beam (the up/down cursor arrow keys always affect
beam height while the left/right cursor arrow keys always affect beam
angle). If you are adjusting an upper beam and you move the left handle
below the note heads, the beam will change to a lower beam. Similarly, if
you are adjusting a lower beam and you move the left handle above the
note heads, the beam will change to an upper beam. Moving the left
handle above or below the center point of a cross beam grouping will
cause the beam to change to an upper or a lower beam, respectively.
When the selected beam has been adjusted to your satisfaction, click the
right mouse button or press ENTER to complete the operation, and the
mouse pointer will return to its normal arrow shape. To abort the adjust
operation at any time, press ESCAPE.

To adjust one or more beams simultaneously, use the mouse to draw a
range around the beam or beams you wish to adjust (be careful to include
all note heads and beam symbols). From the Range Edit menu that
appears, select Adjust. The first three options in the submenu allow you
to specify whether you want to adjust all beams, only upper beams, or
only lower beams. Select one of these three, and the beam height and
beam angle adjust handles appear, as described in the previous paragraph.
Follow the directions in the previous paragraph to adjust your beams.

Next

The Next menu item allows you to select between two objects that are
overlapping (for example, a note and a ledger line).
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Deleting Symbols Using the
Keyboard
Symbols that are entered from the keyboard can be deleted by putting the
cursor on the symbol (exactly where it was entered) and pressing
DELETE and then the key combination that was used to enter the
symbol.
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Tools

Text Tool
The A is the text tool. Select it when you want to enter text. To enter text,
first create a box by dragging the mouse. (Click and hold down the left
mouse button, move the mouse down and to the left, and then release the
left mouse button.) Now you can enter text into the box.

The box can be moved by dragging with the right mouse, and resized by
dragging the boundaries. Clicking outside an open text box closes it.
Clicking on a closed text box opens it.

You can change the font for the text in the current and subsequent text
boxes using the Font menu item under the Character menu.

Automatic Ledger Lines Tool
This tool allows you to toggle the automatic ledger lines function on or
off. When ledger lines are present in the box, the automatic function is
on; any new notes you add above or below a staff will automatically have
ledger lines added. To turn this function off, simply click on the box once
- the ledger lines will disappear and any new notes you add above or
below a staff will be placed without ledger lines. When you start Copyist,
automatic ledger lines are set to on.

Note Size Tool
This tool allows you to toggle between normal and small-sized note
heads, accidentals, beams, stems and clef symbols. When a full-sized note
is displayed in the box (the default), all newly entered note heads,
accidentals, beams, stems and clef symbols will be full size. Clicking on
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the tool causes a small note to be displayed, and all newly entered note
heads, accidentals, beams, stems and clef symbols will be small-sized.

Non-adjustable Symbols Palette
Tool
Clicking on the non-adjustable symbols palette tool causes the palette of
non-adjustable symbols to pop up. When you click on the symbol you
want to enter, the palette will disappear and the symbol you have selected
will be displayed on the tool. (When you first launch Copyist, the bass
clef symbol is shown.) The selected symbol can now be placed anywhere
in the score editor by shift-dragging (pressing and holding the computer
keyboard SHIFT key while pressing and holding the left mouse button
and moving the mouse).

Adjustable Symbols Palette Tool
Click on this tool to cause the palette of adjustable symbols to pop up.
When you click on the symbol you want to enter, the palette will
disappear and the icon on the tool will change to the symbol you selected.
(When you start Copyist, the Tie Up symbol is shown.)

The symbol you selected can be placed anywhere in the score editor by
positioning the mouse pointer and then clicking and holding the right
mouse button while dragging (usually downward or to the right).
Adjustable symbols always have one or more adjustable handles which
appear as open or closed diamonds. While an adjustable symbol is being
placed or adjusted, the mouse cursor changes to a cross. For most
adjustable symbols, the top handle stretches it upwards, the bottom
handle stretches it downwards, and the middle handle allows for free
movement of the symbol anywhere on the screen.

To adjust the symbol during placement, click on any of the handles and
press and hold the left mouse button while dragging. After you have the
symbol placed and adjusted correctly, you drop it on the screen by
clicking the right mouse button or by pressing the ENTER key. If you
change your mind and decide not to drop the adjustable symbol (either
before or after adjusting it) press the ESCAPE key and the symbol will
disappear.
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Page Select Tool
In the center of this tool you see the number of the page in your score you
are currently viewing. Clicking the page number itself brings up a small
dialog box; type in the number of the page you wish to go to and Copyist
will immediately jump to that page. When you click on the right arrow
the next page is brought up onscreen and when you click on the left arrow
the previous page is brought up onscreen.

Insert Page Tool
Click on this tool to insert a new page before the current page.

Delete Page Tool
Click on this tool to delete the current page.
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Status Area

The status area is at the bottom of the Copyist window. This area
provides you with some visual indicators of the status of Copyist.

Current Page
The current page number and the maximum page are displayed in the area
first from the left in the status area.

Cursor Position
The current X and Y cursor position are displayed in the area second from
the left in the status area.

Keyboard Command Keystrokes
The third area from the left in the status area shows you the keys that
you've pressed when entering symbols from the keyboard. When a
keyboard command has been completed, "Ready" is displayed in the
keystroke area.

Menu Item Description
In the area furthest to the right in the status area the description for the
currently highlighted menu item is displayed. When no menu item is
highlighted, "Ready" is displayed in this area.
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Menus

File Menu

New

Select New to create an empty, unnamed Copyist file. It is not necessary
to close any currently open files before selecting a new file. If you have
edited the currently open file and haven't saved it, Copyist will ask you if
you wish to save it before loading the new file.

Open

Select Open to open a file that already exists. This option brings up the
Windows Open File dialog.  If you have edited the currently open file and
haven't saved it, Copyist will ask you if you wish to save it before loading
the new file.

Save

Choose Save to save your file. If you have not named your file yet, the
Save As dialog appears and you will be able to give a name to your new
file before you save it.

Save As

Choose Save As when you want to save your work to a file with a new
name.
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Export Picture

Select Export Picture to save a page of a Copyist score in BMP or TIFF
format. Select the resolution you want from the submenu that appears.
Bear in mind that the quality of the image and the size of the file
generated increase with the resolution.

A file selection dialog box appears. In the Save File as Type list box
select either BMP or TIFF. Now enter the name of the file to which you
wish to save your page and click on OK or press ENTER.

You can now import your saved score into another application. To do
this, follow the directions specified in the documentation for this
application.

Print

Select Print to print you Copyist file.

Print Setup

Select Print Setup to select a new printer or change aspects of your
printing which depend on your printer.

Quit

Select Quit to exit Copyist. Any changes not saved before quitting will
be lost. Before exiting, you will be given a chance to save your work.

Edit Menu

Undo

Undo  restores the last edit or entry. You can even undo the undo
operation.
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Paste

Paste pastes the most recently cut or copied symbols at the cursor
location. When you first paste a selection, the cursor changes to a cross.
At this point you can move the pasted symbols anywhere on the page
using the mouse or the arrow keys. Once you have them positioned
correctly, drop the symbols onto the screen by pressing ENTER or
clicking the right mouse button. Press ESCAPE to cancel the paste
operation.

Character Menu

Text Font

Select the Text Font menu item to bring up the Windows Font dialog.
This allows you to change the font for the text in any text boxes you
create.

User Symbols

Select User Symbols to bring up the symbol editor .

Each Copyist file can make use of up to twenty user-defined symbols
(user symbols) unique to that file. User symbols are created in the symbol
editor. When you edit and save symbols, two special files are created with
the same filename as the current file, and with the extensions of .FT1 and
.FT3, for screen fonts and printer fonts, respectively. If you edit symbols
in a file which has not yet been saved, Copyist will create the files
UNTITLED.FT1 and UNTITLED.FT3.

In the symbol editor, screen or printer symbols are created by dragging
the mouse within the smaller box (for screen symbols) or larger box (for
printer symbols). If you start on a white pixel, the next pixels will be
black as long as the mouse is down, and vice versa.

Clicking on the left arrow button copies from the current screen symbol
to the current printer symbol.
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Clicking on the right arrow button copies from the current printer symbol
to the current screen symbol. Clicking on a number (1 to 20) will select
that symbol.

The File menu for the symbol editor contains Read Symbol, which
allows you to read a symbol from another symbol file (it reads the same
symbol number as the current symbol, reading in both screen and printer
symbols), Save, which saves the current symbol file, Revert, which
restores the last saved version of the current symbol file (canceling all
unsaved changes to all symbols in the current file!) and Quit, which exits
the symbol editor.

The Edit menu for the symbol editor contains Copy, Paste and Clear.
Copy will copy the contents of the current printer or screen symbol to the
clipboard, where it can be pasted back to another symbol, either to a
printer symbol or to a screen symbol. Clear will clear both the screen and
the printer versions of the current symbol.

Pasteboard
Select Pasteboard to open a pasteboard page which you can use to store
and transfer any portion of a score. You can paste many different objects
to the pasteboard without erasing the previously stored objects. You can
edit in the pasteboard as in any other page. If you wish, you can save the
pasteboard using the Save File menu command. To exit the pasteboard,
select Exit Pasteboard.

Help Menu

Contents

Select Contents to get help on Copyist. Navigate through Help by
clicking on green text or by using the Help buttons or menus. For more
information on Help, see your Windows User's Guide.
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About

Select About to bring up Copyist's about box, with credits for the
program and the version number of your copy of Copyist.
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How To

Enter a staff
Click on the Adjustable Symbols button in the Copyist Toolbar. The
Adjustable Symbols palette will appear, showing you all of Copyist's
adjustable symbols.

Select the kind of staff you want (either regular, single-line drum staff or
six-line guitar staff) by clicking on it. The staff you choose appears on the
Adjustable Symbols button.

Now enter the staff symbol on your page by moving the mouse pointer to
where you want to enter your staff and clicking the right mouse button.
The staff will appear, with three adjustment handles which let you change
the shape of the staff and move the staff before you drop it onto the page.

If you want to move the start point of the staff, click the left mouse button
on the left adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the left adjustment handle and changing the start point of the
staff.

If you want to move the end point of the staff, click the left mouse button
on the right adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the right adjustment handle and changing the end point of the
staff.

If you want to move the staff up or down, click the left mouse button on
the middle adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the middle adjustment handle and moving the staff position up
or down.
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Once you have properly adjusted and positioned the staff, click the right
mouse button or press the ENTER key to drop the staff onto the page.
You can press the ESCAPE key if you want to cancel the operation.

You can adjust the staff after you have entered it, by double clicking on
the beginning of the staff (this is always the middle of the top line of the
staff, at the far left edge of the page) and selecting Adjust from the edit
menu that appears.

Enter a bar line
Click on the Adjustable Symbols button in the Copyist Toolbar. The
Adjustable Symbols palette will appear, showing you all of Copyist's
adjustable symbols.

Select the kind of bar line you want by clicking on it. The bar line you
choose appears on the Adjustable Symbols button.

Now enter the bar line symbol on your page by moving the mouse pointer
to where you want the top of your bar line to appear and dragging the
right mouse button downward to where you want the bottom of the bar
line to appear. The bar line will appear, with three adjustment handles
which let you change its shape and move it before you drop it onto the
page.

If you want to move the top of the bar line, click the left mouse button on
the upper adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the top adjustment handle and changing the top of the bar line.

If you want to move the bottom of the bar line, click the left mouse
button on the bottom adjustment handle to select it and then drag the
handle by clicking and holding down the left mouse button and moving
the mouse, dragging the bottom adjustment handle and changing the
bottom of the bar line.

If you want to move the bar line up, down, left or right, click the left
mouse button the middle adjustment handle to select it and then drag the
handle by clicking and holding down the left mouse button and moving
the mouse, dragging the middle adjustment handle and moving the
position of the bar line.

Once you have properly adjusted and positioned the bar line, click the
right mouse button or press the ENTER key to drop the bar line onto the
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page. You can press the ESCAPE key if you want to cancel the
operation.

You can adjust the bar line after you have entered it, by double clicking
on the beginning of the bar line (this is always the top of the bar line) and
selecting Adjust from the edit menu that appears.

Enter a clef
Click on the Non-adjustable Symbols button in the Copyist Toolbar. The
Non-adjustable Symbols palette will appear, showing you all of Copyist's
non-adjustable symbols.

Select the kind of clef you want by clicking on it. The clef you choose
appears on the Non-adjustable Symbols button.

Now enter the clef symbol on your page. Do this by holding down the
SHIFT key and clicking and holding down the left mouse button. The
clef will appear at the mouse cursor. As you continue to hold down the
SHIFT key and to hold down the left mouse button, you can move the
mouse and the clef will follow, until you have positioned the clef where
you want it on the page. When the clef is positioned where you want it,
lift the left mouse button and the clef will be placed onto the page.

If you want to undo the clef entry operation, select Undo from the Edit
menu.

You can move or edit the clef after you have entered it, by double
clicking on the clef and selecting one of the edit operations from the edit
menu that appears.

Enter a time signature
Click on the Non-adjustable Symbols button in the Copyist Toolbar. The
Non-adjustable Symbols palette will appear, showing you all of Copyist's
non-adjustable symbols.

Select the first symbol of the time signature you want by clicking on it. (If
you are enter a common time or cut time signature you only need one
symbol. Otherwise choose the numerator first.) The symbol you choose
appears on the Non-adjustable Symbols button.
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Now enter the time signature symbol on your page. Do this by holding
down the SHIFT key and clicking and holding down the left mouse
button. The time signature symbol will appear at the mouse cursor. As
you continue to hold down the SHIFT key and to hold down the left
mouse button, you can move the mouse and the symbol will follow, until
you have positioned the symbol where you want it on the page. When the
symbol is positioned where you want it, lift the left mouse button and the
symbol will be placed onto the page.

If you need to enter the time signature denominator to complete your time
signature, select it and enter it in its place as you did the numerator.

You can also enter a time signature at the cursor position using keyboard
commands. For example, a cut time symbol  is entered by pressing C then
-, and a 3/4 time signature is entered by moving the cursor until it is
centered on the second line of the staff, pressing 3, then moving the
cursor down until it is centered on the fourth line of the staff and pressing
4.

You can move or edit the time signature after you have entered it, either
by double clicking on each time signature symbol and selecting one of
the edit operations from the edit menu that appears, or by dragging the
left mouse over the complete time signature, drawing a box around it,
lifting up the left mouse button and then selecting one of the edit
operations from the edit menu that appears.

Enter a key signature
Click on the Non-adjustable Symbols button in the Copyist Toolbar. The
Non-adjustable Symbols palette will appear, showing you all of Copyist's
non-adjustable symbols.

If your key signature consists of flats, select the flat by clicking on it. If
your key signature consists of sharps, click on the sharp. The symbol you
choose appears on the Non-adjustable Symbols button.

Now enter each of the accidentals in the key signature on your page. Do
this by holding down the SHIFT key and clicking and holding down the
left mouse button. The accidental will appear at the mouse cursor. As you
continue to hold down the SHIFT key and to hold down the left mouse
button, you can move the mouse and the accidental will follow, until you
have positioned it where you want it on the page. When the accidental is
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positioned where you want it, lift the left mouse button and the accidental
will be placed onto the page.

Continue entering accidentals in this way until you have completed your
key signature.

You can also enter accidentals at the cursor position using keyboard
commands. For example, a sharp is entered by pressing s, and a flat is
entered by pressing f.

You can move or edit the key signature after you have entered it, either
by double clicking on each accidental in the key signature and selecting
one of the edit operations from the edit menu that appears, or by dragging
the left mouse over the complete key signature, drawing a box around it,
lifting up the left mouse button and then selecting one of the edit
operations from the edit menu that appears.

Enter note heads
Click on the Non-adjustable Symbols button in the Copyist Toolbar. The
Non-adjustable Symbols palette will appear, showing you all of Copyist's
non-adjustable symbols.

Select the note head you want by clicking on it. The note head you
choose appears on the Non-adjustable Symbols button.

Now enter the note head symbol on your page. Do this by holding down
the SHIFT key and clicking and holding down the left mouse button. The
note head will appear at the mouse cursor. As you continue to hold down
the SHIFT key and to hold down the left mouse button, you can move
the mouse and the note head will follow, until you have positioned it
where you want it on the page. When the note head is positioned where
you want it, lift the left mouse button and the note head will be placed
onto the page.

You can also enter note heads at the cursor position using keyboard
commands. For example, a closed black note head is entered by pressing
b, and a half note head is entered by pressing h.

You can move or edit the note head after you have entered it, by double
clicking on the note head and selecting one of the edit operations from the
edit menu that appears.
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   Without ledger lines

To enter notes above or below the staff without ledger lines, click once on
the automatic ledger lines tool in the Copyist toolbar (the second button
from the left). The ledger lines on the button will disappear. Now notes
entered above or below the staff will appear without ledger lines.

To enter notes above or below the staff with ledger lines, click on the
button again so that the ledger lines are visible on the button. Now notes
entered above or below the staff will appear with ledger lines.

   Small-sized notes

To enter small-sized notes, click once on the note size tool in the Copyist
toolbar (the third button from the left). The note on the button will change
to a small-sized note. Now notes and accidentals will be entered at small
size. To change back to normal-sized notes, click on the note size tool
again so that the note changes to a normal-sized note. Now notes and
accidentals will be entered at normal size.

Beam a group of notes
First select the notes you want to beam by dragging the mouse over them.
Do this by clicking and holding down the left mouse button and moving
the mouse until you have encompassed all the symbols, and then
releasing the mouse button. The selected notes are highlighted in reverse
video and an edit menu appears. Select Beam from the edit menu. Choose
one of the durations from the submenu, and then either Beam Up or
Beam Down from the next submenu.

If you want more than one duration for your beamed grouping (for
example a dotted eighth beamed with a sixteenth), choose Complex for
the duration and then Beam Up or Beam Down from the next submenu..
Now for each note in your group, select the duration for that note from
the dialog that appears. The Skip Note option in this dialog gives you the
opportunity to leave selected notes within the group unbeamed.

If you are beaming a single note head, a stem and flags are added to your
note head according to the duration and direction you specified from the
beaming submenus.
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   Crossed beaming

To create crossed beaming, first beam your group of notes as you would
normally, creating a beamed group with beams either up or down.

Now double click on the left edge of the beam group and select Adjust
Beams from the edit menu that appears. Two handles will appear. Drag
the beam up or down by dragging the left handle up or down until the
beam is where you want it.  Drag the right handle and the angle of the
beam will change accordingly. When you have positioned the beam so
that it is crossed as you want it, press ENTER or click the right mouse
button to complete the operation. To cancel the adjust operation, press
ESCAPE.

Beam a single note
Stems are created by pressing + (plus) or - (minus) followed by a
duration value. Possible duration values are 4, 8, 1, 3 and 6. When
creating stems, the stem will go up from the cursor position if the -
key is pressed, and down if + is pressed. For example, to put an
upward sixteenth note stem and flag on a notehead, put the cursor
over the notehead, press - and then press 1. To put a downward
eighth note stem and flag on a notehead, put the cursor over the
note, press + and then 8.

It is also possible to beam single notes the same way you beam a
group of notes, that is by selecting the note to be beamed by
dragging the mouse over it and then selecting Beam from the Edit
menu.

Enter a crescendo
Click on the Adjustable Symbols button in the Copyist Toolbar. The
Adjustable Symbols palette will appear, showing you all of Copyist's
adjustable symbols.

Select the crescendo symbol. The crescendo now appears on the
Adjustable Symbols button.
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Enter the crescendo symbol on your page by moving the mouse pointer to
where you want the left edge of your crescendo to appear and then
holding down the right mouse button and dragging the mouse to the right.
The crescendo will appear, with three adjustment handles which let you
change its shape and move it before you drop it onto the page.

If you want to move the start of the crescendo, click the left mouse button
on the left adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the handle and moving the start of the crescendo.

If you want to move the end of the crescendo, click the left mouse button
on the right adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the handle and changing the end of the crescendo.

If you want to move the crescendo up, down, left or right, click the left
mouse button on the middle adjustment handle to select it and then drag
the handle by clicking and holding down the left mouse button and
moving the mouse, dragging the handle and moving the position of the
crescendo.

Once you have properly adjusted and positioned the crescendo, click the
right mouse button or press the ENTER key to drop the crescendo on the
page. You can press the ESCAPE key if you want to cancel the
operation.

You can adjust the crescendo after you have entered it, by double clicking
on the beginning of the crescendo and selecting Adjust from the edit
menu that appears.

Enter a slur
Click on the Adjustable Symbols button in the Copyist Toolbar. The
Adjustable Symbols palette will appear, showing you all of Copyist's
adjustable symbols.

Select the slur symbol (immediately to the right of the trill). The slur now
appears on the Adjustable Symbols button.

Enter the slur on your page by moving the mouse pointer to where you
want the beginning of your slur to appear and dragging the right mouse
button to the right. The slur will appear, with four adjustment handles
which let you change its shape and move it before you drop it onto the
page.
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If you want to move the start of the slur, click the left mouse button on
the left adjustment handle to select it and then drag the handle by clicking
and holding down the left mouse button and moving the mouse, dragging
the handle and moving the start of the slur.

If you want to move the end of the slur, click the left mouse button on the
right adjustment handle to select it and then drag the handle by clicking
and holding down the left mouse button and moving the mouse, dragging
the handle and changing the end of the slur.

If you want to change the shape of the slur, click the left mouse button on
one of the middle adjustment handles to select it and then drag the handle
by clicking and holding down the left mouse button and moving the
mouse, dragging the handle and changing the shape of the slur.

Once you have properly adjusted and positioned the slur, click the right
mouse button or press the ENTER key to drop the slur on the page. You
can press the ESCAPE key if you want to cancel the operation.

You can adjust the slur after you have entered it, by double clicking on
the beginning of the slur and selecting Adjust from the edit menu that
appears.

Enter a guitar grid symbol
There are two ways to enter a guitar grid symbol. The first is to do
everything by hand and is only recommended if your tablature symbol is
not a standard size.

Click on the Adjustable Symbols button in the Copyist Toolbar. The
Adjustable Symbols palette will appear, showing you all of Copyist's
adjustable symbols.

Click on the guitar grid symbol without finger positioning marks on the
frets The guitar grid symbol now appears on the Adjustable Symbols
button.

Enter the guitar grid symbol on your page by moving the mouse pointer
to where you want the beginning of your tab to appear and dragging the
right mouse button to the right. The guitar grid will appear, with three
adjustment handles which let you change its shape and move it before
you drop it onto the page.

If you want to move the start of the guitar grid, click the left mouse
button on the left adjustment handle to select it and then drag the handle
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by clicking and holding down the left mouse button and moving the
mouse, dragging the handle and moving the start of the guitar grid.

If you want to move the end of the guitar grid, click the left mouse button
on the right adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the handle and changing the end of the guitar grid.

If you want to move the guitar grid, click the left mouse button on the
middle adjustment handles to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the handle and moving the guitar grid.

Once you have properly adjusted and positioned the guitar grid, click the
right mouse button or press the ENTER key to drop the guitar grid on the
page. You can press the ESCAPE key if you want to cancel the
operation.

You can adjust the guitar grid after you have entered it, by double
clicking on the beginning of the guitar grid and selecting Adjust from the
edit menu that appears.

Now you can enter the open string and closed string symbols (open and
closed circles). These symbols are found in the Non-adjustable Symbols
palette, and they can also be entered by pressing , (comma) for the open
circle or . (period) for the closed circle.

A simple way to enter a standard guitar grid symbol is to select the guitar
grid symbol containing open and closed string marks from the Adjust
Symbols palette. Click the right mouse button where you want to enter
the guitar grid. The Guitar Chords dialog appears.

You make your guitar chord by selecting a chord from the list box at the
top left of the dialog. You choose a starting fret number from the drop-
down list box under the chord list box. You can set the circles on the
guitar chord frets yourself by clicking on the preview grid wherever you
want to put in a circle. You can only have one circle on any vertical line
so entering a new circle on a vertical line will erase the old one. Circles
entered at the nut will be open. Other circles will be closed. You can erase
a circle by clicking on it.

Create User Symbols
In this example we'll create User Symbol number 6.
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First select the symbol editor by selecting User Symbols from the
Character menu.

Click on number 6 in the grid of numbers at the bottom left of the symbol
editor. The number 6 is highlighted. We'll create a symbol consisting of a
simple rectangular box.

In the symbol editor, screen or printer symbols are created by dragging
the mouse within the smaller box (for what you see on the screen) or
larger box (for what will print on the printer). If you start on a white pixel,
the next pixels will be black as long as the mouse is down, and vice versa.

Create a rectangular box in the screen box by dragging the mouse around
the edge of the box until a black border has been created. Now we'll
transfer the symbol to the printer box by clicking on the right arrow
button.

Save the work you've done by selecting Save from the File menu. Quit
the symbol editor by selecting Quit from the File menu.

Enter User Symbols
Before entering User Symbols, see How to Create User Symbols .

 To enter User Symbol number 6, for example, move the edit cursor to
where you want the User Symbol to appear and type A then 6. To enter
User Symbol number 16, move the edit cursor to where you want the
User Symbol to appear and type A then SHIFT+6. User Symbol number
16 will appear.

Enter text
First, select the Text button (first from the left) in the Copyist toolbar.
Now you can enter text. This is done by clicking the left mouse where
you want the text to start, holding down the left mouse button and
dragging to create a box. Lift the left mouse button. You can now enter
text into the box you have created.

You can select the font for the text you are entering by selecting Text
Font from the Character menu and choosing a font.

You can change the size and shape of the text box you are entering by
dragging one of the edges of the box. The cursor changes shape when you
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are in position to drag one of the edges. You can move the box by
dragging the box with the right mouse button.

When you have finished entering your text, click the left mouse button
outside the text box.

Edit text
To edit text you have already entered, make sure the text icon (the first
button from the left) in the Copyist toolbar is selected. Now click the left
mouse button on the text you want to edit. The text box with the text
editing cursor will appear, allowing you to edit the text.

You can select the font for the text you are editing by selecting Text Font
from the Character menu and choosing a font.

You can change the size and shape of the text box you are editing by
dragging one of the edges of the box. The cursor changes shape when you
are in position to drag one of the edges. You can move the box by
dragging the box with the right mouse button.

When you have finished editing your text, click the left mouse button
outside the text box.

Move a single symbol
Select the symbol you want to move by double-clicking on it. Select
Move from the edit menu that appears. Now you can drag the symbol to
where you want it on the screen. (Drag the symbol by holding down the
left mouse button and moving the mouse.) When the symbol is where you
want it, place it by pressing the ENTER key or by pressing the right
mouse button. Press the ESCAPE key to cancel the move operation.

Move a group of symbols
Select the symbols you want to move by dragging over them with the
mouse (click the left mouse button and while holding it down, drag the
mouse over the symbols you want to move, drawing a box around them,
and then lift up the left mouse button).
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Select Move from the edit menu and then the type of symbols you want
to move from the submenu that appears. Now you can drag these symbols
to where you want them on the screen. (Drag the symbols by holding
down the left mouse button and moving the mouse.)

When the symbols are where you want them, place them by pressing the
ENTER key or by pressing the right mouse button. If you want to cancel
the move operation press the ESCAPE key.

Adjust beams
Double click on the upper left edge of the beam group you wish to adjust
and select Adjust Beams from the edit menu that appears. Two handles
will appear. Drag the beam up or down by dragging the left handle up or
down until the beam is where you want it.  Drag the right handle and the
angle of the beam will change accordingly. When you have positioned
the beam so that it is as you want it, press ENTER or click the right
mouse button to complete the operation. To cancel the adjust operation,
press ESCAPE.

Move notes within a beamed
group
You can move notes within a beamed group, keeping the stems and
beams intact by double clicking on a note within the beamed group and
selecting Adjust Note from the Edit menu.

Now you can move a note within the beamed group with the keyboard
cursor arrow keys or by holding down the left mouse button and dragging
the note to a new position. You can select a new note within the beamed
group by clicking on it with the left mouse button.

When you have positioned the note(s) as you want them, press ENTER
or click the right mouse button to complete the operation. To cancel the
operation, press ESCAPE.
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Adjust an adjustable symbol
Double click on the beginning of the symbol you want to adjust and
select Adjust from the Edit menu. For most adjustable symbols, three
adjustment handles appear which let you change the shape of the symbol
and move it before you drop it onto the page. For the slur symbol, you
have four handles.

If you want to move the start of the symbol, click the left mouse button
on the left adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the handle and moving the start of the symbol.

If you want to move the end of the symbol, click the left mouse button on
the right adjustment handle to select it and then drag the handle by
clicking and holding down the left mouse button and moving the mouse,
dragging the handle and changing the end of the symbol.

If you want to move the symbol up, down, left or right, click the left
mouse button on the middle adjustment handle to select it and then drag
the handle by clicking and holding down the left mouse button and
moving the mouse, dragging the handle and moving the position of the
symbol. If you are adjusting a slur, dragging one of the middle handles
will change the shape of the slur.

Once you have properly adjusted and positioned the symbol, click the
right mouse button or press the ENTER key to drop the symbol on the
page. You can press the ESCAPE key if you want to cancel the
operation.

Delete a symbol
Select the symbol to be deleted by double clicking on it. Select Cut from
the Edit menu and the symbol will disappear. (You can paste the deleted
symbol to a new location now if you wish.)

You can also select the symbol to be deleted by dragging a box around
the symbol, selecting Cut from the Edit menu and then selecting an
appropriate choice from the submenu.

You can also delete a symbol entered from the keyboard by positioning
the cursor over the symbol exactly where it was entered and then pressing
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the DELETE key and entering the same keyboard command used to
enter the symbol.

Use the pasteboard
The pasteboard is used to hold temporarily any element or group of
elements of a score you are working on. You can copy from any page in
your score to the pasteboard, edit in the pasteboard and then copy from
the pasteboard and paste back to any page in your score.

Enter the pasteboard by selecting Pasteboard from the Copyist menu.
Exit the pasteboard by selecting Exit Pasteboard.

Undo mistakes
Select Undo from the Edit menu to undo your last edit or entry. If you
want to restore the edit that you undid, select Undo again.

Go to a new page
To go to a new page, click on the page icon in the Copyist toolbar (sixth
button from the left) and select the page you want. This will move you to
that page.

Create a new page
To create a new page, click on the page icon in the Copyist toolbar (sixth
button from the left) and select the last page that can be selected. This will
create a page one after the last page in your score and move you to that
page.
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Insert a page
To insert a page, click on the insert page icon in the Copyist toolbar
(second button from the right). This will insert a new page before the
current page and put you on that page.

Erase a page
To erase a page, click on the erase page icon in the Copyist toolbar (first
button on the right).
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Service and Support

Warranty
This program and the associated documentation are Copyright 1996 by
Sion Software Ltd. This program is licensed to be used on a single
machine. It may not be copied without explicit written permission. If the
program is transferred to another party, all backup copies must be
transferred at the same time, or destroyed. This notice of copyright must
be transferred if you transfer the program, and your license to use the
program is terminated on transfer .

The diskette on which the program is furnished is warranted for a period
of ninety (90) days from the date of delivery. The program is not
guaranteed to meet your requirements, and operation of the program is
not guaranteed to be interruption or error free. In no event will Sion
Software or its employees be liable for any damages, including any lost
savings, lost profits, or other incidental or consequential damages arising
out of the use of or inability to use this program, even if we have been
advised of the possibility of damages. Sion Software shall not be
responsible for any damages claimed by any other party, resulting from
the use or attempted use of this program. All warranties implied are with
Sion Software, not your local dealer. If problems arise, please call Sion
Software directly.

The various products mentioned in this manual are registered or pending
trademarks of their respective manufacturers.

Upgrades And Replacements
Sion Software reserves the right to make improvements to the program
without notice, and to make what Sion Software considers to be
reasonable charges for updates and upgrades.
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There is a $19.95 charge for the replacement of program disks that
become defective more than 90  days after the date of purchase.

When returning the disks for replacement or updates, please send them by
UPS, Federal Express, Express Mail, or some other service that will allow
you to trace the shipment. We’re sorry, but we cannot be responsible for
packages sent via regular US mail.

Service And Support
Extensive efforts have been made to ensure that the information contained
in this manual is accurate and that the program is error  free. This is,
however, an imperfect world. Should you discover any bugs, errors, or
portions of the manual that are not clear, kindly send your comments to
Sion Software so that they may be considered for inclusion in future
revisions of Copyist.

Please take the time to fill in the registration card that’s in the package.
There are at least two good reasons for becoming a registered owner:

1. As a registered owner, you will be notified automatically of any
updates to Copyist.

2. As a registered owner, you will be entitled to free technical support
for Copyist.

What To Do If Problems Arise
If you have problems with Copyist that you are unable to resolve after a
careful reading of the manual, Sion Software maintains both customer
service and technical support  lines. We are happy to help you with
questions regarding Copyist, but due to the extraordinary variety of music
related products available today and the number of possible system
configurations, we cannot answer questions regarding hardware or
software from other manufacturers. This includes questions on the basic
operation of the IBM PC or other computers or musical instruments.
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Customer Service
Customer Service is for owners who need replacement disks, upgrade or
update information, or who wish to purchase software. The telephone line
for customer service is the main number for Sion Software:
(604) 222-2454. Customer service personnel are unable to help you with
technical questions. If you have questions concerning technical matters,
please phone the technical support line.

Technical Support
Technical support is for owners who are having difficulties with the
installation or operation of Copyist. When calling Sion Software for
technical support, there are a number of things that you can do to help us
help you (which can also save you money on your phone bill!). Here is a
checklist of things to have ready before calling:

1. Your diskette registration number.

2. Your manual.

3. Your computer turned on and Copyist running.

4. Any information that can help us solve the problem, especially
information about how to repeat your problem. If you cannot
duplicate a problem, it is very difficult for a technician to figure out
what is wrong!

5. Information on your computer’s make, model, disk configuration,
memory installed, sound source, monitor type, MIDI interface type if
installed, and so on.

6. Paper and pencil for taking notes.

When you call us, we’ll walk you through the program and ask you
questions about what happens. It is very important that you have the
above materials at hand when calling. If you don’t have this ready, we
will ask you to call back later with the required information.

After you have completed the checklist, call us at (604) 222-2455
between 10 AM and 2 PM Pacific Standard Time, Monday through
Friday. We’ll do everything we can to get you on the road to making
music with Copyist.
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You may also email technical support questions to:
sionsoft@infoserve.net or take a look at our web site at:
http://www.infoserve.net/quickscore for answers to your questions .
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